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Abstract

Reynolds, Keith M. 1999.  EMDS users guide (version 2.0): knowledge-based
decision support for ecological assessment. Gen. Tech. Rep. PNW-GTR-470.
Portland, OR: U.S. Department of Agriculture, Forest Service, Pacific Northwest
Research Station. 63 p.

The USDA Forest Service Pacific Northwest Research Station in Corvallis, Oregon,
has developed the ecosystem management decision support (EMDS) system. The
system integrates the logical formalism of knowledge-based reasoning into a geo-
graphic information system (GIS) environment to provide decision support for eco-
logical landscape assessment and evaluation. The knowledge-based reasoning
schema of EMDS uses an advanced object- and fuzzy logic-based propositional
network architecture for knowledge representation. The basic approach has several
advantages over more traditional forms of knowledge representations, such as
simulation models and rule-based expert systems. The system facilitates evaluation
of complex, abstract topics, such as forest type suitability, that depend on numer-
ous, diverse subordinate conditions because EMDS is fundamentally logic based.
The object-based architecture of EMDS knowledge bases allows incremental, evo-
lutionary development of complex knowledge representations. Modern ecological
and natural resource sciences have developed numerous mathematical models to
characterize highly specific relations among ecosystem states and processes; how-
ever, it is far more typical that knowledge of ecosystems is more qualitative in
nature. Approximate reasoning, as implemented in fuzzy logic, significantly extends
the capability to reason with the types of imprecise information typically found in nat-
ural resource science. Finally, the propositional network architecture of EMDS
knowledge bases allows both the ability to evaluate the influence of missing infor-
mation and the ability to reason with incomplete information.

Keywords: Ecosystem management, ecological assessment, knowledge base,
decision support, geographic information system, ecosystem analysis, ecosystem
states, ecosystem processes.
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System Requirements 1

Component Required Recommended

Input device Mouse

Applications ArcView 3.0a

NetWeaver 1.1g

Operating system Windows 95 Windows 95 or Windows NT 4.0

Processor Pentium CPU

RAM 32 MB 64 MB

Screen resolution 640 by 480 pixels 800 by 600 pixels or better

Color resolution 256 colors 256 colors or better

Text Formatting Conventions

The following conventions are used for text formatting in EMDS help:

PLAIN UPPERCASE TEXT indicates a folder (directory) or file name.

Italic text indicates a graphic object such as a button, menu choice, etc.

Plain bold  text is used for emphasis.

System Installation and Initial Setup

Installing EMDS

To install EMDS:

1. Load the EMDS distribution CD in the CD drive.

2. Open Windows Explorer in Windows 95 (or File Manager in Windows 3.1).

3. Select the CD icon to display the folders (directories) on the drive.

4. In the tree view (left pane), click on the root icon to highlight it, if necessary.

5. In the contents pane, double click on SETUP.EXE to run the EMDS setup
application.

1 The use of trade or firm names in this publication is for reader
information and does not imply endorsement by the U.S. De-
partment of Agriculture of any product or service.
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6. When the setup application starts, it first asks for the drive and folder to which
EMDS should be installed. Either accept the default location, C:\EMDS, or
specify a new drive or folder name, then press the OK button.

7. SETUP.EXE checks for available hard disk space and installs the EMDS
application to the specified location if there is adequate disk space, and then
creates an EMDS group on the Windows 95 Taskbar (or a EMDS group window
in Windows 3.1).

If the drive to which EMDS is to be installed does not have sufficient space, then
SETUP.EXE displays a dialog window with a warning. Press the OK button in the
dialog window to return to step 6. If there are no alternative drives to which EMDS
can be installed, you may either press the Exit button to abort installation or leave
SETUP.EXE running, switch to Windows Explorer, delete folders to create adequate
space for the installation, and return to SETUP.EXE to resume installation.

Running EMDS Sample Projects

EMDS is distributed with a set of sample projects. A folder for each sample project
is in the \EMDS\SAMPLES folder. ArcView 3.0a or later must be installed on your
system to open the sample projects.

To open a sample project:

1. Press the Start button on the Windows Taskbar.

2. Choose the Programs item on the Start menu.

3. Choose the EMDS group item.

4. Choose the EMDS application item.

5. In the EMDS startup dialog window, press the Open button to display the Open
project dialog window.

6. Select a sample project from the list box and press the OK button.

7. When prompted for a password, enter “littlebuddy” without quotes, and press the
OK button.

Refer to later chapters, “ArcView System” and “Assessment System,” for instruc-
tions about viewing and running sample assessments.



1

Ecosystem management decision support (EMDS) version 2.0 is an application
framework for knowledge-based decision support of ecological assessments
(Reynolds and others 1996, 1997a, 1997b). The EMDS framework is designed to
conduct analyses for any geographic scale. The system integrates state-of-the-art
geographic information system (GIS) and knowledge-based reasoning technologies
in the Microsoft Windows® (hereafter, Windows) environment to provide an analy-
tical tool that is powerful but easy to use. EMDS version 2.0 is not a complete de-
cision support system for the full adaptive management process of ecosystem
management; however, it provides a solid foundation on which to build a more
comprehensive system.

EMDS is described as an application framework because it is not “ready to run out
of the box.” Instead, the system provides a general solution method (for example, a
framework) for conducting ecological assessments. To conduct an assessment with
EMDS, the user:

1. Constructs a template view that includes all GIS themes that can enter into an
assessment.

2. Constructs knowledge bases that describe relations among ecosystem states
and processes of interest to the assessment.

EMDS integrates two key applications to support these activities. In particular,
NetWeaver provides a knowledge-base development environment, and the EMDS
extension to ArcView includes system objects and methods for processing knowl-
edge bases in a GIS application. There are three significant advantages to the
EMDS architecture for landscape analysis:

IntroductionIntroductionIntroductionIntroductionIntroduction
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1. Topics included in an assessment, relations among ecosystem states and proc-
esses in the knowledge base, and sources of data are completely determined by
the user, who has control of problem definition.

2. Knowledge bases developed for one area are easily adapted to other areas.

3. Assessment applications can be developed somewhat generically for a larger
region, then easily be customized for specific subregions.

Designing and setting up the template view for knowledge-based analysis in
ArcView generally require an hour or less, assuming databases for the assess
-ment area already exist. Simple knowledge bases can be built in a few days. More
complex knowledge bases may require a few weeks to construct.

A Brief History

The initial analysis phase of system development began in January 1994, with the
first meeting of the cooperators. Initial design specifications were completed in
January 1995. The initial task order to the Environmental Systems Research In-
stitute (ESRI) and Knowledge Garden, Inc., for the first phase of system implemen-
tation was issued in February 1995. Since then, a series of task orders has been
issued for incremental development of the system. EMDS version 1.0 was com-
pleted in March 1997. Beta testing of EMDS began in December 1996 on three
ecoregional assessments being conducted by the USDA Forest Service. EMDS
version 2.0 was completed in October 1998.

EMDS Features

Version 1.0 provided support for:

1. Constructing knowledge bases with NetWeaver that describe logical relations
among ecosystem states and processes of interest in an assessment.

2. Selecting analysis topics and processing the knowledge base to get a
geographic assessment of ecosystem states and processes at the level of
landscape features.

3. Evaluating the influence of missing data on the completeness of an assessment.

4. Prioritizing new data acquisition given the influence of data.

5. Performing analyses of alternative scenarios.

6. Basic project management.
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Major enhancements in version 2.0 include:

1. Use of multiple GIS themes in a single analysis.

2. Tools for attributing polygons with information about their nearest neighbors.

3. Support for ArcView GRID format.

4. Automatic generation of the Data Catalog at run time, based on attributes of
themes contained in template views.

5. ArcView hotlink from EMDS map output to a NetWeaver browser that displays
evaluated states of a knowledge base for features selected by the user.

Overview of EMDS System Components

The basic architecture of EMDS and the flow of information among system compo-
nents are illustrated in figure 1. The EMDS ArcView extension provides the primary
system interface in which an assessment team:

1. Defines a template view containing themes for all attributes relevant to an
assessment.

2. Defines an assessment area.

3. Reviews geographic attributes of an area as a prelude to assessment.

4. Reviews results of an assessment in maps, tables, graphs, and evaluated
knowledge base structure.

The NetWeaver interface (fig. 1) provides a knowledge-base development environ-
ment in which an assessment team assembles a knowledge base that describes
the logical relations (dependencies) among topics of interest to an assessment,
underlying ecosystem states and processes, and data needed to evaluate topics,
states, and processes.

The Assessment system includes three subsystems (fig. 1). The basic interface of
the Assessment system provides an interface to NetWeaver knowledge bases to:

1. Select topics of interest in the assessment.

2. Define custom sets of analysis topics for future reference.

3. Run an analysis with the NetWeaver engine that processes the knowledge base.

4. Select maps of evaluated ecosystem states and processes to display in
ArcView.
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The Data Acquisition Manager (DAM) is the first Assessment subsystem (fig. 1).
The DAM prioritizes missing data by using information about the influence of
missing data and information gathered from the user about the ease of acquiring
missing data. This subsystem is an aid to planning new data collection to improve
completeness of an assessment. A variety of maps, tables, and graphs provides
useful information about which data are missing, the influence of missing data on
completeness of the assessment, and how these data are distributed in the
landscape.

The second Assessment subsystem is the Hotlink Browser (fig. 1). After map output
for an analysis has been displayed in ArcView, the standard ArcView hotlink tool can
be used to select map features for display in the Hotlink Browser. The browser dis-
plays the evaluated knowledge base state for the selected feature in a manner
similar to the graphic display used in NetWeaver.

The third Assessment subsystem is the Scenario (not illustrated in fig. 1). Scenario
provides methods for editing and evaluating copies of input databases to perform
“what if” analyses.

Figure 1—Object diagram of basic EMDS system architecture.
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Key Concepts

Landscape Feature

The ArcView user guide (Anonymous 1996) states, “A theme is a collection of geo-
graphic phenomena that you define. The geographic phenomena are represented in
[a] database by geometric elements such as polygons, lines, or points. These are
referred to as feature classes.” Individual elements of a theme are features. For ex-
ample, there may be a theme representing the stream network in a watershed. Indi-
vidual line segments in this case might correspond to stream reaches (segments
within which stream characteristics are considered essentially uniform). A stream
reach is an example of a feature in the stream network theme. The concept of land-
scape features is central to EMDS because analyses performed on an assessment
area are performed on each feature in that area.

Influence of Missing Data

In the future, assessment teams may be able to assemble a list of all topics they
want to include in an assessment, assemble a list of data requirements needed to
address those topics, then find that they have all the required data. In the meantime,
assessments routinely need to deal with incomplete data. There may be some
missing observations for several to many datum types. There may be no data at all
for (possibly) many others.

One solution to the problem of missing data is to tailor an assessment to existing
data. This is a poor way to conduct an assessment of environmental phenomena
with complex interrelations, however. This type of approach makes it extremely dif-
ficult, if not impossible, to infer what is not known about the data that might be rele-
vant and how influential it might be for completing an analysis of ecosystem states
and processes. Instead, it is preferable to construct a model that reflects the best
understanding of how all states and processes relevant to the assessment are inter-
related. The NetWeaver engine incorporated into EMDS uses a simple algorithm to
compute the influence of missing data based on the logical structure of the knowl-
edge base, how many states and processes use the information, and at what level
the information enters a knowledge base structure. The DAM in EMDS uses infor-
mation about data influence to help users prioritize new data acquisition needs.

Knowledge Base

Knowledge base applications (Jackson 1990, Waterman 1986) began to appear in
significant numbers in natural resource management in 1983 (Davis and Clark
1989). In a more recent survey, Durkin (1993) cataloged more than 100 knowledge
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base applications in the environmental sciences. O’Keefe (1985) envisioned an
important role for knowledge base systems as components of larger decision sup-
port systems in the future.

A knowledge base embodies knowledge about how to solve a problem in some
domain of interest. Several different approaches to knowledge-based representa-
tion have been developed during the last 30 years (Schmoldt and Rauscher 1995).
EMDS incorporates the NetWeaver engine for knowledge-based reasoning
(Saunders and others 1990, Stone and others 1986). This system implements a
knowledge base as hierarchies of dependency networks. By itself, a knowledge
base does not actually do anything. The knowledge base that an assessment team
constructs with NetWeaver is best thought of as a metadatabase. It is used to
interpret data processed by the inference engine. For additional discussion about
the structure of NetWeaver knowledge bases, see the “NetWeaver System” chapter
in this manual and the NetWeaver user guide (Reynolds 1999).

Knowledge-Based Reasoning

Knowledge-based reasoning (or equivalently, symbolic reasoning) is a general
modeling methodology in which phenomena are described in terms of abstract
entities and their logical relations to one another. There are two basic reasons for
using knowledge-based reasoning:

1. The entities, or their relations, involved in the problem to be solved are
inherently abstract so that mathematical models of the problem are difficult to
formulate.

2. A mathematical solution is possible in principle, but current knowledge is too
imprecise to formulate.

Both cases are quite common in environmental sciences. The first case naturally
arises when the nature of the problem involves inherently abstract “things.” Such
problems may be easier to solve with logic. The second case arises frequently be-
cause, particularly when dealing with natural systems, there is an almost unlimited
number of relations of potential interest. Agencies, academia, and others have
developed numerous mathematical models to describe some of the important rela-
tions for ecosystem management, but many have not been studied in adequate de-
tail to provide sufficiently general mathematical solutions. There often is a wealth
of human experience in these same institutions, however, that can be drawn
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upon to develop useful, more qualitative, knowledge-based models to guide
decisionmaking. One other valuable aspect of symbolic reasoning that makes it
ideal for use in ecological assessment is that such systems can reason with in-
complete information. The NetWeaver engine provides partial evaluations of eco-
system states and processes based on available information, and provides useful
information about the influence of missing data that can be used to improve
completeness of an assessment.

Inference Engine

There are two basic parts of a knowledge-based reasoning system:

1. The knowledge base itself, which defines the entities of the problem domain,
their relations to one another, and perhaps some of their states.

2. The inference engine, which operates on the knowledge base and external data
sources (performs the knowledge-based reasoning) to draw conclusions about
the state of the system.

In EMDS, the user builds a knowledge base in NetWeaver that describes the prob-
lem domain. Performing an assessment entails running the inference engine on the
knowledge base.

Fuzzy Logic

Basic concepts of approximate reasoning with fuzzy logic were first presented by
Zadeh (1965, 1968). Subsequent concept papers (Zadeh 1975a, 1975b, 1976)
elaborated on the syntax and semantics of linguistic variables, laying the foundation
for what has now become a significant new branch of mathematics. Fuzzy logic
focuses on quantification of set membership and associated set operations.
Formally (Kaufmann 1975),

let E be a set, denumerable or not, and let x be an element of E. Then a fuzzy
subset A of E is a set of ordered pairs {×, µ

A
(×)}, " × ∈  E, in which µ

A
(×) is a

membership function that takes its values from the set M = [0, 1], and specifies
the degree of membership of × in A.

Fuzzy set theory is a generalization of boolean set theory, and most boolean set
operations have equivalent operations in fuzzy subsets (Kaufmann 1975, p. 11).

Application of fuzzy logic to natural resource science and management is still rel-
atively new. General areas of application include classification in remote sensing
(Blonda and others 1996), environmental risk assessment (Holland 1994), phyto-
sociology (Moraczewski 1993a, 1993b), geography (Openshaw 1996), ecosystem
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research (Salski and Sperlbaum 1991), and environmental assessment (Smith
1995, 1997). More specific applications include catchment modeling (Anonymous
1994), cloud classification (Baum and others 1997), evaluation of plant nutrient
supply (Hahn and others 1995), soil interpretation (Mays and others 1997,
McBratney and Odeh 1997), and land suitability for crop production (Ranst and
others 1996).

The EMDS design team selected the NetWeaver knowledge-base engine for
integration into EMDS because of its implementation of fuzzy logic-based reason-
ing. Compared to classical rule-based systems (Waterman 1986), knowledge repre-
sentation for problem specification using fuzzy logic is more precise, compact, and
efficient. The team was convinced, moreover, that the combination of propositional
logic networks with fuzzy logic-based reasoning, as implemented in NetWeaver,
would make knowledge-based solutions to ecological assessments far more
feasible than classical methods owing to the implementation of object-based design
(Booch 1994) and consequent support for evolutionary design of complex system
specifications (Gall 1986).
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The EMDS Help system is accessed from the Assessment menu of ArcView. In
version 2.0, Help is implemented in hypertext markup language (HTML). Selecting
the EMDS Help menu item starts the web browser configured for use with EMDS.

The display area is divided into a contents frame on the left and a topic display
frame on the right. Contents items preceded with a + symbol are expandable.

• Click on the + symbol in front of an item to expand the outline for that topic.

• Click again (now a - symbol) to collapse.

To view a topic displayed in the contents:

• Click on the item to highlight it, then press the Display page button, or

• Double click on the item.

Blue text in the body of a text explanation indicates a hyperlink (displayed in blue by
default). Click on a hyperlink to go to the indicated topic or figure. Text links are
displayed in the same right frame. Use the browser’s Back button to return to the
previous topic. Links to figures are displayed in a new browser window. Close the
window when you are finished viewing a figure.

EMDS Online HelpEMDS Online HelpEMDS Online HelpEMDS Online HelpEMDS Online Help
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ArcView Features

The EMDS ArcView extension adds an important additional menu to the standard
ArcView menus for EMDS-specific functions, but all other aspects of the ArcView
interface remain unchanged (fig. 2). ArcView makes basic GIS technology acces-
sible to a broader audience than the Arc GIS development system, which requires a
significant amount of training to gain proficiency. ArcView is still a powerful and
sophisticated application, however, that requires at least 2 to 3 hours for user
proficiency. For documentation about use of standard ArcView features in EMDS,
see the ArcView users guide (Anonymous 1996). Users new to ArcView will want to
view the ArcView tutorial.

ArcView and EMDS Projects

The EMDS ArcView extension is one of the primary components of the EMDS
system (fig. 1). The extension adds additional objects and methods to ArcView to
support knowledge base processing in the GIS environment. ArcView is organized
around the concept of a project. It will be useful to review the help topics, “projects”
and “project window,” in the ArcView Help system for a basic orientation to the
ArcView interface if you are not familiar with the basic operation of ArcView.
ArcView is central to the operation of EMDS; applications built with the EMDS
ArcView extension are referred to as EMDS projects.

ArcVArcVArcVArcVArcView Systemiew Systemiew Systemiew Systemiew System
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There is a basic hierarchical structure to EMDS:

• A real-world assessment (that is, the total process conducted by an
assessment team) may consist of multiple EMDS projects.

• A single EMDS project may contain multiple assessments.

• A single EMDS assessment may contain multiple analyses.

Multiple EMDS Projects

An actual assessment may involve analyses at multiple geographic scales. Although
a single EMDS project is capable of storing all data references for all scales of
analysis for an actual assessment, users may find it useful to set up a separate
EMDS project for each major geographic scale of analysis. The main advantage to
separate EMDS projects by geographic scale is that two or more assessment
subteams may work in parallel on different scales of analysis.

Multiple EMDS Assessments Within an EMDS Project

An EMDS assessment is always associated with a specific landscape unit or a set
of landscape units. A single EMDS project may contain multiple assessments. An
EMDS assessment can, but does not need to, have a one-to-one relation to an
actual assessment (that is, one being conducted by an assessment team).

Figure 2—ArcView interface with custom assessment menu added by EMDS.
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An EMDS assessment is defined by selecting an analysis area in the Index view
within ArcView (fig. 2). Definition of the analysis area is flexible because the area
can be any collection of landscape features within a given theme of the Index view,
and the features need not be contiguous. Multiple assessments within an EMDS
project are needed under two conditions:

1. The actual assessment includes different scales of analysis. Each scale of
analysis requires at least one EMDS assessment.

2. Within a given scale of analysis, there are two or more sets of landscape units
for which you want to conduct separate analyses.

Multiple Analyses Within an EMDS Assessment

Typically, multiple analyses are conducted on a given assessment area, because
each NetWeaver knowledge base is designed to evaluate attributes associated with
a specific landscape feature or a specific set of features. For example, one analysis
may be based on attributes of stands, while another in the same EMDS assessment
is based on attributes of counties. The two scales are approximately the same, but
each analysis focuses on a different type of landscape feature as the unit of
analysis.

As of version 2.0, analyses of knowledge bases now can use data from multiple
themes, given certain compatibility requirements among theme types. Knowledge
bases requiring different combinations of themes still might result in the need for
different analyses.

EMDS Data Engine

The Data Catalog is an ArcView table that stores references to numerous, diverse
types of data, including data from different themes. The Data Catalog concept
implemented in version 1.0 (a persistent data lookup table created by the user) has
been replaced by the Data Engine in version 2.0. The Data Catalog still exists as a
data structure in version 2.0, but now it is assembled during analysis by the Data
Engine from the contents of the Template view that has been designated for the
assessment. Each record in the Data Catalog identifies:

1. The name of the data link as defined in the knowledge base.

2. The name of the GIS theme with which the variable is associated.

3. The ArcView name for the variable.

4. The name of the field in the attribute table associated with the theme.

5. The file name of the attribute table.
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6. Directory information that specifies the location of the attribute table on the local
system or on a local area network.

Attribute tables may be in any database format supported by Microsoft Open Data-
base Connectivity (ODBC), including Microsoft Access, Borland FoxPro, dBASE,
and ORACLE. For a complete list of ODBC-supported database formats, see the
Microsoft ODBC documentation.

See the section, “Knowledge Base Processing,” below, for an explanation of how
the Data Catalog is used by the NetWeaver engine to evaluate a knowledge base.

Views

In ArcView, a view is a window that displays thematic maps of geographic informa-
tion. Each view window is subdivided into a map pane and a table of contents pane
(fig. 2). A theme within the map pane is activated (turned on) or deactivated (turned
off) by clicking on its name in the table of contents. An activated theme appears
slightly raised in the table of contents. ArcView Help provides extensive documenta-
tion about standard ArcView operations that apply to views.

This section briefly introduces three EMDS-specific views that a user interacts with
while setting up and conducting an assessment. Later sections in this chapter
provide specific instructions about how to create these views.

Index View

After an EMDS project has been set up, the Index view of a project is automatically
displayed when the project APR file is opened (fig. 2). The Index view displays the
geographic extent of a region and the boundaries of potential assessment areas
within that region. Multiple assessment boundary themes can be included in the
Index view to define different scales of assessment within the region. For example,
a single Index view might contain a regional boundary, physiographic province
boundaries, and watershed boundaries.

Template View

The default set of themes that appears in the Assessment view (see the following
subsection) is determined in the Template view (fig. 3). Multiple Template views
can be defined within an EMDS project. There are three basic choices:

1. One Template view that applies to all scales of assessment.

2. One Template view for each scale of assessment.

3. Multiple alternative Template views for any given scale.
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When a new assessment is first created, ArcView prompts to select the Template
view (from a list of the available Template views) to associate with the new
Assessment view. Once an assessment has been saved, the Template view
originally assigned to it becomes permanently associated with that assessment. The
Data Engine uses the contents of the Template view associated with an assessment
to construct a Data Catalog during analysis. Consequently, a Template view must
contain all the themes that have attribute data needed by a knowledge base for an
analysis.

Assessment View

After creating a new assessment or opening an existing assessment from the
ArcView Assessment menu, a new view is opened for the selected assessment
area based on the Template view selected (fig 3.). The Assessment view has three
primary functions in EMDS:

1. Before conducting an assessment of an area, the Assessment view can be used
to become familiar with basic landscape attributes of the area for problem
orientation.

2. Once an assessment has been performed, evaluated ecosystem states and
processes can be examined in the Assessment view.

Figure 3—An EMDS Template view determines which themes are displayed in the Assessment view.
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3. The Assessment view also can be used to examine the distribution of missing
data and its relation to road systems (for example) as an aid to deciding how
difficult it will be to acquire missing data and how to prioritize new data
acquisition.

The default set of themes that appears in the Assessment view is determined in the
Template view. However, an Assessment view can be customized by the addition of
new themes or the deletion of default assessment themes. See theme topics in
ArcView Help for further information.

Setting Up an EMDS Project

Creating a Base ArcView Project

To create an EMDS project, first create a standard ArcView project that contains a
set of views and themes to import into the EMDS project. Below, this standard
ArcView project is referred to as the base project because it will be the basis for
creating an EMDS project.

1. Start ArcView 3.0a (or later version).

2. In the empty ArcView project (see following sections for details about each of
the three steps).

a. Create an Index view.

b. Create a Template view.

c.  Assign ArcView aliases.

3. Save the ArcView project (this is the base ArcView project).

Creating an Index view—The Index view contains one or more themes from which a
user can select a specific assessment area for analysis. To create an Index view in
ArcView:

1. Highlight the Views icon in the ArcView project window.

2. Select the New button at the top of the ArcView project window to create
“view1.”

3. Choose the Rename view1 menu item from the Project menu.

4. In the dialog window that opens, type “Index view” to rename the new view.

5. With the Index view window open and active (highlighted), choose the Add
theme menu item from the View menu.
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6. In the dialog window that opens, enter the name of an existing theme that
delineates possible assessment areas as features.

To move additional themes to the Index view, repeat steps 5 and 6.

Creating a Template view—A Template view defines the default set of GIS themes
that will be available in the Assessment view when a new assessment is started or
an existing assessment is opened. The Template view must contain all the themes
that contain attribute data needed by a knowledge base for an analysis. To create a
new Template view:

1. Highlight the Views icon in the ArcView project window.

2. Select the New button at the top of the ArcView project window to create
“view1.”

3. Reselect the ArcView project window to make it the active window and choose
the Rename view1 menu item from the Project menu.

4. In the dialog window that opens, type “Template view - X” to rename the new
view, where X indicates a brief descriptor to distinguish among multiple
Template views.

5. With the new Template view window open and active (highlighted), choose the
Add theme menu item from the View menu.

6. In the dialog window that opens, enter the name of an existing theme that
delineates possible assessment areas as features.

7. Optionally, to see how themes will display, use the ArcView selection tool to
select an example assessment area and zoom the display to the extent of the
selected feature.

8. Repeat steps 5 and 6 to add themes that might be useful to have in the
Assessment view.

Assigning ArcView aliases—In this step, the names of data links in a NetWeaver
knowledge base are associated with data table fields. The Template view may con-
tain one or more themes. Each theme displayed in the view’s table of contents has
a table associated with it that contains attribute data associated with the features of
the theme. The field name in the table is the name of the column in the data source.
The field alias is the corresponding name for the NetWeaver data link.
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To set up the association between NetWeaver data link names and ArcView theme
field aliases:

1. If necessary, select the Views icon in the ArcView project window to display the
available views.

2. Select the appropriate Template view in the ArcView Project window.

3. Select the Open button at the top of the ArcView Project window to open the
Template view.

4. Activate the theme in the Template view’s table of contents whose fields include
data to be accessed by NetWeaver.

5. Press the Open theme table button on the ArcView Button bar.

6. Choose the Properties menu item from the Table menu on the ArcView Menu
bar.

7. Locate the fields within the open table that correspond to the data inputs to be
associated with NetWeaver data links. These appear in the column labeled
“Field.” Be sure that the name of the NetWeaver data link entered in the alias
field is exactly the same as it appears in NetWeaver, including case, spaces,
and any punctuation.

8. In the column labeled “Alias,” enter the corresponding NetWeaver data link
name.

9. Close the table.

10. Repeat steps 4 through 9 for each theme in the Template view that contains
data fields used by the knowledge base.

EMDS version 2.0 allows an assessment to use multiple themes for analyses be-
cause the Data Engine generates a Data Catalog from the table of contents of a
Template view when an assessment area is first defined. The Data Catalog for
knowledge base processing can be assembled from the following combinations
of themes in the table of contents of a Template view:

1. Any number of polygon themes can be joined by intersection.

2. One line theme and any number of polygon themes. Polygons are first joined by
intersection with one another, then the new polygon theme generated by
intersection is joined to the line theme.

3. One point theme and any number of polygon themes. Polygons are first joined
by intersection with one another, then the new polygon theme generated by
intersection is joined to the point theme.
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A single Template view may contain multiple line and point themes. However, at-
tempts to specify multiple line or point themes as data sources in a given assess-
ment will generate an error at the time of Data Catalog creation because multiple
themes of these types cannot be joined. A theme becomes a data source for
analysis when it contains a NetWeaver alias identifier.

Creating a New EMDS Project

1. Choose the EMDS item under the EMDS program group on the Windows 95 or
Windows NT Taskbar.

2. In the Startup application window, press the New button or choose New from the
Project menu.

3. Complete the edit lines in the New project dialog window to specify a short name
for the project (this name is displayed in the Project list box, discussed below in
“Managing EMDS Projects”), a longer descriptive name for the project, the full
path name for the new project folder (directory), and an optional password for
the project.

4. Press the OK button in the New project dialog window.

When step 4 is completed, the Startup application creates the new project folder,
copies all folders from the \EMDS\TEMPLATES folder to the new project folder, and
creates a custom EMDS.INI file in the new project APR folder. Information entered
at step 3 also is added as a new record to \EMDS\PROJECTS\PROJECT.RAP
which maintains basic information about all EMDS projects.

Completing Setup of a New EMDS Project

1. Choose the EMDS item under the EMDS program group on the Windows 95 or
Windows NT Taskbar.

2. In the EMDS Startup application, press the Open button or choose Open from
the Project menu.

3. In the Open project dialog window, select the project to open from the list box
and press the OK button to open the selected EMDS project.

4. With the ArcView Project window active, choose Import on the ArcView Project
menu to import the base ArcView project into the new EMDS project. In the
Import dialog window, navigate to the folder that contains the base ArcView
project, select the project, and press the OK button to import it into the EMDS
project. The index view and any Template views from the base project now have
been imported into the EMDS project.
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5. In the Project window, highlight the Index view that contains the themes from the
base ArcView project to be used in the EMDS project. Press the Open button to
open the view. Activate the themes to be copied in the Table of contents of the
Index view, and choose Copy themes on the Edit menu.

6. Highlight the Assessments Index view in the Project window, open the Assess-
ments Index view, and choose Paste on the Edit menu.

Neighborhood Attribute Tool

Once an ArcView base project has been imported into an EMDS project, the Neigh-
borhood attribute item can be selected from the Assessment menu to associate
simple statistics on attributes of neighboring polygons with the features in a selected
theme in a Template view. The neighborhood attribute tool iterates through the list of
features in the selected theme, treating each feature as the current subject polygon,
and computing a selected statistic on a selected data field in all neighboring poly-
gons. Neighbors of a subject polygon are those polygons whose centroids are within
a specified radial distance from the centroid of the subject polygon.

To use the neighborhood attributes tool:

1. Open the Template view containing the theme to be processed by the neighbor-
hood attribute tool.

2. Select the theme in the view’s table of contents to make it the active theme in
the view.

3. Select the Neighborhood attributes item from the Assessment menu to open the
Neighborhood attributes dialog window (the menu item is only enabled on the
Assessment menu after a theme has been activated in step 2).

4. Fill in the edit line for the ArcView data field name to assign to the statistic.

5. Fill in the edit line for radial distance that specifies the neighborhood of each
subject polygon.

6. Select the name of the data field in the Neighbor attribute list box that contains
the neighbor attribute to associate to each subject polygon.

7. Select the statistic to apply from the Statistic drop-down list box.

8. Press the OK button to close the dialog window and begin processing the
polygons.
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After statistical processing of the theme has been completed, the theme now con-
tains the new data field with the name assigned in step 4. Repeat steps 3 through 8
to create as many new data fields with neighborhood attributes as necessary. To
include the newly created data field(s) in subsequent analyses, follow the proce-
dures outlined in the section, “Assigning ArcView aliases,” above.

Using EMDS with GRID and Spatial Analyst

EMDS version 2.0 can process themes with GRID data, greatly extending the spa-
tial operations that potentially can be performed in EMDS. In particular, if ESRI’s
Spatial Analyst extension is available on the same computer as EMDS, Spatial
Analyst may be added as an extension to EMDS. A detailed discussion of Spatial
Analyst and its GRID processing capabilities are beyond the scope of this manual.

For a more thorough treatment of spatial operations available in Spatial Analyst, see
Anonymous (1997).

Managing EMDS Projects

EMDS Startup is an EMDS helper application that provides basic project manage-
ment for EMDS projects. Its most important functions are creating new EMDS pro-
jects and opening existing projects as described in the previous two sections. Al-
though it is possible to setup new projects and open them from Windows Explorer
in Windows 95 or Windows NT, it is strongly recommended that you use EMDS
Startup to manage these processes because the application takes care of setting
up and managing INI files used by EMDS.

EMDS Startup provides the following additional functions for project management:

• Setup and maintenance of project passwords.

• Adding project folders for projects originally created on a different computer.

• Deleting projects.

ArcView Assessment Menu

This section covers the custom menu added to ArcView for EMDS applications
(fig. 2). For documentation about standard ArcView features of EMDS, see the
ArcView user guide (Anonymous 1996) or online documentation in ArcView Help.
The following menu choices are available on the Assessment menu (fig. 2):

• New Assessment opens a dialog window to enter a name for a new
assessment. See the section, “Assessment Management,” “Creating a New
Assessment” for additional information.
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• Open Assessment opens a dialog window to select the name of an existing
assessment to open. Only one assessment may be open at any given time. If
an assessment is opened, and there is already one open, the latter is closed
before opening the next one.

• Close Assessment closes the currently loaded EMDS assessment. If no
assessment has been opened, this menu item has no effect.

• Save Assessment saves the current state of all assessment files associated
with the open assessment.

• Show Assessment Window provides initial entry into the EMDS Assessment
system.

• Neighborhood attribute tool provides basic support for generating statistics on
neighbor attributes that can be associated with polygons and included in
analyses.
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NetWeaver is a knowledge base development system that has been incorporated
into EMDS. It provides a framework for constructing knowledge bases. The
NetWeaver user guide (Reynolds 1999) and the NetWeaver Help system provide
extensive documentation about how to use the system to construct knowledge
bases for environmental assessment. This section summarizes basic attributes of
NetWeaver knowledge base architecture and how NetWeaver knowledge bases are
processed in EMDS.

Relation of Analysis Topics to NetWeaver Networks

A NetWeaver knowledge base is a hierarchy of dependency networks (fig. 4). Each
network corresponds to a topic of interest in the problem domain represented by the
knowledge base. There is a one-to-one correspondence between networks in a
NetWeaver knowledge base and topics that are available to be included in an
analysis within the Assessment system.

NetWeaver Engine

The NetWeaver engine is a Windows dynamic link library (DLL) developed by Rules
of Thumb, Inc. (North East, PA). The NetWeaver knowledge base development
environment is an interface to the engine that is used for constructing knowledge
bases (fig. 5). The EMDS Assessment system also is an interface to the NetWeaver
engine; under the direction of the Assessment system, the engine processes the
hierarchy of dependency networks specified by the knowledge base (fig. 6) to
produce an assessment of ecosystem states and processes.

NetWNetWNetWNetWNetWeaver Systemeaver Systemeaver Systemeaver Systemeaver System
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Figure 4—The basic structure of a NetWeaver knowledge base is a hierarchy of dependency networks.

Figure 5—The NetWeaver knowledge base development environment.
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NetWeaver Knowledge Bases

NetWeaver knowledge bases are object-based. There are two basic types of object:
the dependency network  and the data link  (fig. 4), each of which is represented in
the network structure by a programming object that has both state and behavior.

Dependency Networks

A knowledge base represents knowledge about how to solve a problem (in this
case, how to evaluate topics of interest in an assessment) in terms of the topics
of interest in the problem domain, and the relations (dependencies) among these
topics. Each dependency network in a NetWeaver knowledge base represents a
proposition about the condition of some ecosystem state or process.

State—The key state variable of a dependency network is its truth value which
expresses the degree to which evidence from antecedent dependency networks

Figure 6—NetWeaver knowledge base processing.
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and data links support or refute the proposition. Logically, network A is antecedent
to network B, if B depends upon A, because network A must be evaluated before
network B can be evaluated.

Behavior—The basic function of a dependency network is to evaluate the truth of its
proposition. NetWeaver dependency networks have three basic behaviors related to
this function:

1. They query their antecedents to determine the latters’ state.

2. They evaluate their own state, given the state of their antecedents.

3. They inform higher level networks that depend on them about their state.

Data Links

A data link is an elementary dependency network with slightly modified behavior.

State—Like a dependency network, a data link may evaluate to a truth value, given
a data input. A data link also may hold an actual data value that is subsequently
transformed by mathematical operations defined for a calculated data link.

Behavior—

1. When using the NetWeaver development environment, data links prompt the
user for data input. When an analysis is being performed within the Assessment
system in EMDS, data links request data from the system, which passes the re-
quest to the Data Engine in ArcView (fig. 1).

2. On receipt of data, data links evaluate their state, given the data input (simple
data links), or pass the data value to a special data link that performs some
transformation of input data (calculated data link).

3. They inform higher level networks that depend on them about their state.

Truth Values

The truth value is the basic state variable of both dependency networks and data
links. It expresses an observation’s degree of membership in a set that represents
some concept, such as good gravel cover in spawning beds or good elk habitat.
Evaluations of degree of set membership are quantified in the semantics of fuzzy
logic (Zadeh 1965, 1968, 1975a, 1975b, 1976, 1986, 1992, 1995).

Data links are frequently used to read a datum (for example, percent gravel cover)
and evaluate its degree of membership in a concept that is quantified in a fuzzy
argument (an argument that quantifies fuzzy set membership). Thus, in a data link
the argument is a mathematical statement of a proposition. Some simple examples
include:
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• If the datum fully satisfies the argument, then the truth value of the data link is 1
(true).

• If the datum is fully contrary to the argument, then the truth value of the data
link is -1 (false).

• If the datum partially satisfies the argument, then the truth value of the data link
is in the open interval (-1, 1). Note that negative truth values greater than -1 do
not connote negative truth. Rather, such values connote low membership.

• If the datum is not known, then the truth value of the data link is 0
(undetermined).

Interpretation of truth values within networks must be treated more generally,
because the truth value of a network may depend on several to many fuzzy logic
operators. Simple examples related to the two key fuzzy logic operators, AND
and OR, are:

• If all logical paths antecedent to a fuzzy AND operator fully support the AND
relation, then the truth value of the operator is 1 (true).

• If any logical path antecedent to a fuzzy AND operator is fully contrary to the
AND relation, then the truth value of the operator is -1 (false).

• If any logical path antecedent to a fuzzy OR operator fully supports the OR
relation, then the truth value is 1 (true).

• If there is no evidence for or against an AND or OR relation, then the truth
value of either operator is 0 (undetermined).

As with data links, networks also may evaluate to partially true. Two conditions that
result in this condition in NetWeaver:

1. One or more data items are missing and cannot be supplied, and therefore
contribute a value of 0 to a fuzzy AND.

2. One or more data items that influence the truth value of a dependency network
have been evaluated against a fuzzy argument and been found not to have full
membership in the fuzzy set defined by the fuzzy argument.

Knowledge Base Processing

Knowledge base processing in EMDS is performed by the NetWeaver engine. Data
input to the engine is mediated by the Assessment system, and the Data Engine in
ArcView. The interaction of these three system components is summarized as
follows (fig. 1):
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1. When the Data req(uirements) button is pressed in the Assessment system, the
NetWeaver engine traces the dependencies for the top-level networks that have
been selected for analysis down through the structure of the knowledge base to
find the data links required to conduct an analysis (fig. 6).

2. The NetWeaver engine returns a list of required data links to the Assessment
system.

3. The Assessment system passes the list of data requirements to the Data
Engine. The latter ArcView subsystem is a custom component of ArcView
whose operation is transparent to the user.

4. The Data Engine uses the list of data requirements to look up appropriate data-
base field name cross-references in the Data Catalog and to determine the
status of the fields (present in or absent from the Data Catalog). A status table
is assembled in ArcView and automatically displayed.

5. When the Run button is pressed in the Assessment system, the latter requests
that the ArcView Data Engine retrieve the data from the appropriate fields in the
appropriate databases.

6. The Data Engine makes the appropriate queries to the databases, and assem-
bles the returned data into an input data table that is processed by the data links
of the knowledge base.

7. Evaluations cascade upward through the hierarchy of dependency networks until
the top-level networks that initially were selected for analysis have been fully
evaluated (fig. 6).
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Assessment Management

Whereas activities in ArcView are organized around the concept of a project, activi-
ties within an EMDS project are organized around the concept of an assessment.
Assessments can be conducted at any geographic scale. Each assessment is
associated with a specific assessment area that is selected in the ArcView Index
view (fig. 7). The scale of the assessment and its related analyses also are defined.

The main folder for an EMDS project contains a \PROJECTS subfolder when the
project is created (see “Creating new EMDS Project” in the “ArcView System” chap-
ter). Each time a new assessment is created from the ArcView Index view, EMDS
creates a new subfolder (for example, \PROJECT_A) in the \PROJECTS subfolder
with a unique user-supplied name. Multiple assessments can be associated with a
single geographic area, allowing the area to be partitioned into two or more sepa-
rate assessments if desired. This might be desirable if, for example, two or more
teams were working somewhat independently on different aspects of an assess-
ment. Multiple EMDS assessments within an EMDS project are required under
two conditions:

1. The actual assessment includes different scales of analysis. Each scale of
analysis requires at least one EMDS assessment.

2. Within a given scale of analysis, there are two or more sets of landscape units
for which separate analyses are desired.

Assessment SystemAssessment SystemAssessment SystemAssessment SystemAssessment System



29

Creating a New Assessment

1. Activate the appropriate theme in the Index view (fig. 7).

2. Select the assessment area within the theme with the ArcView selection tool.

3. Choose New Assessment from the ArcView Assessment menu.

If more than one Template view exists for the EMDS project, then a dialog window
is displayed following step 3. Select the appropriate Template view from the list to
use for the assessment and press the OK button to complete the creation process.
At step 2 the ArcView selection tool can be used to select multiple contiguous fea-
tures within the active theme in the Index view to define an assessment area as a
collection of areas (fig. 7).

Opening an Existing Assessment

1. Choose Open Assessment from the ArcView Assessment menu (fig. 7).

2. A dialog window displays the names of assessments that have been created
within the EMDS-ArcView project in a list box.

3. Click to highlight the name of the assessment to open in the list box.

4. Press the OK button.

Figure 7—Defining a new assessment in the Index view.
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Saving an Assessment

Saving an assessment saves the current state of the Assessment view. If an analy-
sis has been run, and any themes displaying results have been generated for that
analysis, then the Assessment view is saved with the new results themes included
in its table of contents, and these themes will be available the next time that the as-
sessment is opened. To save an assessment, choose Save Assessment from the
ArcView Assessment menu.

Assessment System Components

The EMDS Assessment system is an interface to the NetWeaver engine and con-
sists of three main subsystems (fig. 1).

• The Hotlink Browser provides graphical displays of the evaluated states of a
knowledge base for landscape features that have been selected in themes
generated by an analysis and displayed in the Assessment view.

• The DAM assists with setting priorities for missing data.

• Scenario lets the user alter data inputs and override default knowledge base
evaluation to explore alternative scenarios.

Most control of these subsystems is achieved through the Assessment button bar or
the Assessment menu bar, which are documented in the following two subsections
(fig. 8). The operation of each subsystem is detailed in the three subsections
following description of the assessment interface.

Instantiated Knowledge Bases

EMDS knowledge bases created with NetWeaver are not modified directly by the
Assessment system. An analysis adds specifications to the knowledge base, but
these specifications are stored separately from the knowledge base in analysis files.

Specifications for an analysis include which topics have been selected for analysis,
topics that are to be ignored, and values applied to specific topics. An instance of
the knowledge base is created by applying the specifications to a copy of the knowl-
edge base. The knowledge base then is said to be instantiated.

Assessment Interface

The Assessment system is the basic interface to the NetWeaver knowledge base
engine within EMDS and provides methods to:

1. Start a new analysis or load an existing analysis.

2. Select topics to be included in an analysis.
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3. Select topics to define custom sets of analysis topics for future reference.

4. Run an analysis with the NetWeaver engine to process a knowledge base.

5. Display maps of evaluated ecosystem states and processes in ArcView.

6. View evaluated states of the knowledge base for landscape features selected in
analysis themes displayed in the Assessment window.

7. Create alternative scenarios by modifying data inputs to and structure of the
knowledge base.

Assessment Button Bar

• The function of each button (fig. 8) also is replicated on the Assessment
menu bar. Most window objects discussed in this section also are illustrated
in figure 8.

• New analysis loads an uninstantiated version of the currently loaded knowledge
base. It duplicates the function of New analysis on the File menu.

• Open analysis loads an existing analysis (instantiated knowledge base) and
initializes the knowledge base to its previously evaluated state. It duplicates the
function of Open analysis on the File menu.

Figure 8—Assessment system interface.
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• Save saves the current state of an analysis (instantiated knowledge base). If an
analysis has not been run yet, the Save button must be pressed before press-
ing the Data req(uirements) button, otherwise an error message is displayed
informing you to save the analysis first. An analysis can be saved after select-
ing a number of topics, then reloaded later to continue selecting additional
topics; however, any change in knowledge base state resulting from additional
topic selections or topic deletions requires resaving before getting data require-
ments. As a security measure, each set of modifications of this type requires a
new analysis name. This helps assure that analyses are not overwritten inad-
vertently. It duplicates the function of Save analysis on the File menu.

• Group defines the current set of selected topics (networks in NetWeaver termi-
nology) in the Available topics window as a custom group for future use in the
present analysis. A dialog window opens, requesting a name for the group. On
closing the dialog window, the group is added to the list of topics in the Avail-
able topics window. It duplicates the function of Make group on the Group
menu.

• Show toggles display of the topic hierarchy in the Available topics window
between display of all topics and display of user-defined groups only. It
duplicates the function of Show groups on the Group menu.

• Data req(uirements) assembles data requirements for knowledge base proc-
essing. The Save button must have been pressed first or an error message is
displayed. The Data req button also must be pressed before pressing the Run
button if the analysis has never been run. After the initial run of an analysis, it
is no longer necessary to press the Data req button before pressing the Run
button. It duplicates the function of Summarize data needs on the Analysis
menu.

• Run performs the analysis. It duplicates the function of Run analysis on the
Analysis menu. See Save and Data req(uirements) on the Assessment button
bar for important notes about how these three buttons interact.

• Print prints an ASCII script of the current instantiation of the knowledge base
for the analysis. It duplicates the function of Print on the Analysis menu.

• Help displays the contents page of EMDS Help.

• Exit exits the EMDS Assessment system. If the current analysis has been
edited since the last save, the Assessment system prompts, asking if it should
be saved.
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Assessment Menu Bar

The function of commonly used menu items is replicated on the Assessment button
bar (fig. 8). Most window objects also are illustrated in figure 8.

File menu—

• New analysis loads an uninstantiated version of the currently loaded knowledge
base.

• Open analysis loads an existing analysis (instantiated knowledge base) and
initializes the knowledge base to its previously evaluated state.

• Save saves the current state of an analysis (instantiated knowledge base).
Save must be selected before choosing Summarize data needs on the Analysis
menu or an error message is displayed informing you to save the analysis first.
A knowledge base can be saved after selecting a number of topics, then re-
loaded later to continue selecting additional topics. Any change in knowledge
base state resulting from additional topic selections or topic deletions requires
resaving before getting data requirements. As a security measure, each set of
modifications of this type requires a new analysis name. This assures that
specific analyses cannot be overwritten inadvertently.

• Save as is similar to Save, above, except that a new analysis name is specified
in a file name dialog window. The primary reason for using Save as is to create
a copy of an analysis for further editing while keeping a copy of the current
analysis.

• Close closes the analysis that is currently open. If the current analysis has
been edited since the last save, the Assessment system prompts, asking if it
should be saved.

• Exit exits the EMDS Assessment system. If the current analysis has been
edited since the last save, the Assessment system prompts, asking if it should
be saved.

Group menu—

• Make group defines the current set of selected topics (networks in NetWeaver
terminology) in the Available topics window as a custom group for future use in
the present analysis. A dialog window opens, requesting a name for the group.
On closing the dialog window, the group is added to the list of topics in the
Available topics window.
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• Show group toggles display of the topic hierarchy in the Available topics
window between display of all topics and display of user-defined groups only. A
check mark appears next to this menu item only when user-defined groups are
displayed.

Analysis menu—

• Undo include undoes the action of Include selected topic (see below).

• Show antecedents only toggles display of the topic hierarchy. In the default
state, the full hierarchy is displayed in the Available topics window. When this
item is chosen (indicated by a check mark next to the menu item), only the
topic currently selected in the Available topics window and its antecedent topics
are displayed.

• Include selected topics places the set of topics that are currently selected in the
Available topics window in the Topics for analysis window. Any topics included
in the Topics for analysis window are now displayed as bold in the Available
topics window.

• Remove selected topic removes topics that are currently selected in the Topics
for analysis window from that window and removes bold face from these topics
in the Available topics window.

• Summarize data needs assembles data requirements for knowledge base
processing. The Save button on the Assessment button bar or Save menu item
on the File menu of the Assessment menu bar must have been pressed first or
an error message is displayed. Summarize data needs also must be selected
before selecting Run analysis for the first time. After the initial run of a particu-
lar named analysis, Summarize data needs no longer needs to be chosen
before choosing Run analysis.

• Run analysis performs the analysis. See Save on the File menu and Sum-
marize data needs on the Analysis menu for important notes about how these
three menu items interact.

• Print prints an ASCII script of the current instantiation of the knowledge base.

Results menu—

• Map displays a cascading menu (network truth value, missing data indicator,
or data influence rank) to choose a type of map. For an explanation of map
choices, see the section, “Performing an analysis,” “Viewing analysis results,”
below. The map dialog window opens. Choose a topic or data item from the list
box and press the OK button to generate a new ArcView theme for the selected
information. After pressing the OK button, click anywhere on the ArcView win-
dow to bring this window to the foreground and view the resulting map.
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• Define ease of acquisition opens the DAM subsystem, described later in this
chapter.

• Influence summary opens the influence dialog window. Choose an item from
the list box and press the OK button to generate a graph of the selected infor-
mation in ArcView. For information about the types of graphs that can be gen-
erated, see the section, “Data Acquisition Subsystem,” “DAM results,” below.
After pressing the OK button, click anywhere on the ArcView window to bring
it to the foreground and view the resulting graph in ArcView.

• Analysis tables cascades to two additional choices: Show and Hide. Select
Show to automatically display all input and output tables used or generated by
NetWeaver. After pressing the OK button, click anywhere on the ArcView win-
dow to bring it to the foreground and view the set of tables in ArcView. While
in ArcView, tables can be closed manually, one at a time, via the control menu
on each table window. Alternatively, use Analysis Tables-Hide on the Results
menu in the Assessment system to automatically close all NetWeaver input
and output tables.

What-if menu—

Scenario menu item— Scenario is a cascading menu item that contains the
following submenu items:

• New opens a filename dialog window with an edit line to enter a name for a
new scenario.

• Open opens a filename dialog window with a list box to choose the name of an
existing scenario to load.

• Save saves the current state of the currently open scenario.

• Save as is similar to Save, but opens a filename dialog window with an edit line
to enter a new name for the scenario.

• Delete opens a filename dialog window with a list box to choose the name of an
existing scenario to delete from the analysis.

For additional discussion about use of these menu items, see the section,
“Scenarios,” below.

Edit records menu item— This menu item opens the input database table (an
ArcView table) for the currently loaded scenario. If landscape features have been
highlighted in the ArcView EMDS Assessment view, then records corresponding to
these features are highlighted in the input database table when the table is opened.
See “Select features” in ArcView Help for details about this feature.
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Options menu—

• Set password opens the Password dialog window to enter the EMDS
password. The password must be entered before attempting to set truth values
for analysis topics or data values for data links. A password is given initially
only to the assessment team leader when EMDS is installed. The team leader
then decides who should have access to the set value functionality.

• Startup settings opens the Startup dialog window to set default attributes for
the Assessment system. Edit lines in the dialog window allow you to specify
a default knowledge base to load or a specific analysis file (an instantiated
knowledge base). A knowledge base can be specified without specifying a
specific analysis. If an analysis file is not specified, then an uninstantiated copy
of the knowledge base is loaded when the Assessment system opens. To open
a specific analysis file at startup, its associated knowledge base also must be
specified. Radio buttons in the dialog window allow a choice between text
labels or graphic labels for the Assessment button bar.

Help menu—

Contents displays the contents page of Assessment system help.

Search displays the search dialog window of the help system.

How to displays key help topics that discuss how to use the various EMDS features
and functions.

Using help explains use of help system features.

About displays information about EMDS and its designers.

Assessment Windows

The Assessment system displays three child windows within the main Assessment
window (fig. 8):

1. The Available topics window displays a NetWeaver knowledge base as a
hierarchy of topics that can be browsed and selected for inclusion in an analysis.
Use this window to select topics to be included in an analysis and to define
custom sets of analysis topics to be added to the list of available topics in the
knowledge base hierarchy. Details of both operations are explained in the
section, “Selecting topics for analysis,” below.

2. The Details window displays detailed information about the topic that is currently
selected in the Available topics window.

3. The Topics for analysis window displays the list of topics that have been selected
for inclusion in an analysis.
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Available topics window—A NetWeaver knowledge base is a hierarchy of depend-
ency networks (fig. 4). Each network corresponds to a topic of interest in the prob-
lem domain represented by the knowledge base. There is a one-to-one correspond-
ence between networks in a NetWeaver knowledge base and topics that are avail-
able to be included in an analysis within the Assessment system. See the earlier
section, “NetWeaver Knowledge Bases,” for a description of networks and data
links.

All topics represented by dependency networks are available to be selected for in-
clusion in an analysis. The topic hierarchy (which is a transformation of the depend-
ency network structure into hierarchical form) is displayed in the Available topics
window (fig. 8).

Only the highest level topics are displayed initially in the Available topics window
when a knowledge base is first loaded into the Assessment system. To expand the
topic hierarchy beneath a specific topic, press the small expand button immediately
to the left of the topic name. To collapse the topic hierarchy beneath a specific topic,
press the expand button again. Methods for making multiple topic selections con-
form to Microsoft Windows conventions:

• Shift-click  to select a contiguous set of topics.

• Ctrl-click  to select multiple noncontiguous topics.

Once a set of topics has been selected in the Available topics window, it can be
included in the topics for analysis or defined as a custom set of analysis topics for
later reference in the same analysis or derivative analyses.

Selecting topics for analysis— Once a set of topics has been selected in the
Available topics window, the set is added to the Topics for analysis window by
pressing the Include selected topic button in the accessory button set or choosing
Include selected topic from the Assessment menu bar (fig. 8).

Selected topics are displayed in the Topics for analysis window after the Include
selected topic button has been pressed. The selected topics and all their anteced-
ent topics (those on which they depend) are included in the analysis.

Creating custom sets of analysis topics— Once a set of topics has been selected
in the Available topics window, this set can be defined as a custom group of topics
for future reference in the same analysis by pressing the Group button on the As-
sessment button bar or choosing Make group from the Groups menu. In either
case, a dialog window is displayed, requesting a name for the group. After the
dialog window is closed, the new group is added to the list of topics displayed in
the Available topics window.
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To toggle display of the Available topics window between all topics and only custom
groups, press the Show button on the Assessment button bar or choose Show
groups from the Groups menu (fig. 8).

Details window—

Documentation dropdown list box— NetWeaver dependency networks and data
links have several types of documentation attributes, such as comments, explana-
tions, literature references, and assumptions. This information can be viewed, but
not edited, in the Details window (fig. 8).

Use the dropdown list box at the top of the Details window to select a specific doc-
umentation attribute to view. Alternatively, press the maximize button on the Details
window to expand the window to full size and view all details at once.

Type field— The type field identifies whether the topic that is currently selected in
the Available topics window is a group, dependency network, or data link. See the
earlier section, “NetWeaver Knowledge Bases,” for an explanation of these items.

Weight field— The weight field displays the weight associated with the topic or data
link that is currently selected in the Available topics window. With rare exception,
this usually will have a value of 1.0. Weights are not applicable to groups.

Set value edit box— The Set value edit box is empty unless a value is set by the
user. It is used to set a global value  for an analysis topic or data source that ap-
plies to all database records when an analysis is run. Normally, data values that
are applied to NetWeaver data links are read from the appropriate IN.DBF file for
the current analysis. Similarly, topics included in analysis normally are evaluated
by evaluating their antecedent topics. Values for both data sources and analysis
topics can be overridden, however, by the user after an initial analysis has been
run. Changes to truth values of analysis topics and data values for data links can-
not be made in the initial analysis because it generates the tables on which such
edits are performed.

Once an initial analysis has been run, values for either topics or data links may be
set directly in the Set value edit box or via the Set value dropdown list box (see the
next subsection). To set a value for an analysis topic or a data source via the Set
value edit box (fig. 8):

1. Highlight the appropriate item in the Available topics window whose value is to
be set by clicking on it.

2. Click inside the Set value edit box to get an edit cursor.

3. Type in the value to which the item should be set.

4. Click anywhere within the Assessment window.
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See the section, “Setting Values for Topics and Data,” below for additional
information about overriding data sources and evaluation of analysis topics, and
documenting changes to a knowledge base or its data.

The Assessment system performs some basic range and type checking when
values are set via the Set value edit box:

• Truth values of topics either must be in the inclusive range, -1 to 1, or be one of
the predefined constants, True (1), False (-1), or Undetermined (0).

• The value for a data source that has a list of choices associated with it can only
be one of the choices. It is best, however, to use the Set value dropdown list
box in this situation because the latter data entry object displays the choice list.

• The value for a data source can be any real number if the data link does not
have a list of choices associated with it.

Set value dropdown list box— The Set value dropdown list box is displayed to the
right of the Set value box and is used to set a global value for an analysis topic or
data source that is applied to all database records when an analysis is run.

Values may be set directly in the Set value edit box (see the previous subsection) or
via the Set value dropdown list box. To set a value for an analysis topic or for a data
source via the Set value dropdown list box:

1. Highlight the appropriate item in the Available topics window whose value is to
be set by clicking on it.

2. Click on the down arrow on the right side of the list box to open it and display the
set of available choices.

3. Click on one of the choices to set the value of analysis topic or data link.

Choices for analysis topics are:

• True  sets the value of the topic to true.

• False  sets the value of the topic to false.

• Undetermined  forces the value of the topic to remain undetermined  (the
analysis is conducted as if there were no data to evaluate the topic).

• Required  forces any topic that depends on the selected topic to be treated as
unevaluated if the required topic is not fully evaluated.

• Ignore  effectively removes the topic from the knowledge base (the knowledge
base is evaluated as if the topic were not in the knowledge base).
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• Reset  sets the topic to its default condition before running an analysis, which is
the undetermined state. The Reset  option is different from the Undetermined
option, above, because a topic that is reset will be  evaluated in an analysis, but
a topic that is set to  undetermined is forced to remain undetermined .

Choices for data links are:

• A list of data value choices if a choice list was defined for the data link in
NetWeaver.

• Empty  forces the datum for the data link to be treated as missing even if it
exists in IN.DBF (the data link is forced to remain unevaluated).

• Ignore  effectively removes the data link from the knowledge base (the knowl-
edge base is evaluated as if the data link were not in the knowledge base).

• Required  forces any analysis topic that depends on the selected data link to be
treated as unevaluated if the datum for the data link is missing in IN.DBF.

• Reset  sets the data link to its default condition before running an analysis,
which is the undetermined state. The Reset  option is different from the Empty
option, above, because a data link that is reset will be  evaluated in an analysis
but a data link that is set to  empty is forced to remain undetermined .

Annotation button— Press the Annotation button to open an edit window in which
notes may be added concerning the topic that is currently selected in the Available
topics window. Notes are specific to the current analysis or its derivatives; that is, if
notes are added about a topic and the analysis is saved under a new name with the
Save analysis button on the Assessment button bar, the notes are carried into the
new analysis.

The annotation window also is used to document reasons for setting data and
analysis topic values (see the section, “Setting Values for Topics and Data,” below).

Topics for analysis window—This window displays the set of analysis topics that
have been selected for inclusion in an analysis. The Accessory button set (see the
following section), located between the Available topics window and the Topics for
analysis window, is used to add and remove topics from the window (fig. 8).
Alternatively, choose Include selected topic and Remove selected topic from the
Analysis menu to add and remove topics, respectively.

Although not displayed in the Topics for analysis window, any topics that are
antecedent to an included topic (that is, topics on which the included topic depends)
are automatically included in an analysis.
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Accessory Button Set

The Accessory button set used in the Assessment system is arranged vertically and
located between the Available topics window and the Topics for analysis window
(fig. 8).

• The Show/hide hierarchy button toggles display of the topic hierarchy in the
Available topics window. In the default show state, the full hierarchy is dis-
played. Press this button to hide all the hierarchy except the topic currently
selected in the Available topics window. This button duplicates the function
of Show antecedents only on the Analysis menu.

• Include selected topic button places the set of topics currently selected in the
Available topics window in the Topics for analysis window. Any topics included
in the latter window are now displayed as bold in the Available topics window.
This button duplicates the function of Include selected topic on the Analysis
menu.

• Remove selected topic removes topics that are currently selected in the Topics
for analysis window. This button duplicates the function of Remove selected
topic on the Analysis menu.

Setting Values for Topics and Data

Setting values via the Set value edit line or Set value dropdown list box in the
Details window overrides normal knowledge base processing by inserting values
for analysis topics and data links that apply globally to all records processed in an
analysis. The setting values feature can be used in both the standard analysis and
the scenario mode of analysis. Setting values is not allowed, however, until an initial
analysis has been run.

Documentation—There often are compelling reasons to use the set value feature,
but setting values can profoundly influence an analysis and should always be docu-
mented carefully by an assessment team. Any time that the set value feature is
implemented by the user, the Assessment system displays a dialog window with a
message prompting the user to document the set value action. After pressing the
OK button to close the dialog window, the Assessment system displays an edit
window in which to enter relevant documentation. To refer to documentation that
has been entered concerning values that have been set for a particular analysis
topic or data link:

1. Highlight the relevant item in the Available topics window.

2. Press the Annotation button in the Details window.
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Justification for setting values—There are three general cases in which it may be
desirable and justifiable to set values for analysis topics and data links.

1. Actual data are lacking, but there is sufficient circumstantial knowledge about
the missing information to provide reasonable data estimates.

2. One or more individuals may have direct knowledge about the truth value of a
proposition being tested by an analysis topic, in which case they may be willing
to say that the proposition is generally true or false.

3. Setting values for analysis topics and data links is perfectly justifiable in what-if
analysis, if one is looking only at the effects of hypothetical conditions.

Performing an Analysis

The basic steps to performing an analysis within the Assessment system are:

1. Load the knowledge base into Analysis if the Assessment system does not auto-
matically load the desired knowledge base. If the Assessment system automati-
cally loads the correct knowledge base, the loaded knowledge base either may
be instantiated (that is, represents an existing analysis) or uninstantiated, de-
pending on options set from the Options menu (see Options menu in the earlier
section, “Assessment Menu Bar”).

2. Select topics to include in an analysis. If an analysis (instantiated knowledge
base) was loaded at startup of the Assessment system, there may be no need
to select topics. If the topics included for analysis are not changed upon loading
an existing analysis, steps 4 and 5, below, should be skipped.

3. Optionally, create custom sets of analysis topics.

4. Save the current state of the analysis under a new name. Saving is required
whenever the set of topics included in an analysis changes. It is not necessary
to save the analysis after an initial analysis has been run or upon loading an
existing analysis if subsequent changes are made only via the set value function
because the state of the analysis is automatically saved when the Run button is
pressed.

5. Get data requirements to run an analysis if the analysis has never been run.
After the initial run of an analysis, there is no need to get data requirements.

6. Run an analysis. The sequence of operations invoked by the run command are
summarized in the earlier section, “NetWeaver Knowledge Bases,” “Knowledge
Base Processing.”

7. Display maps of truth values associated with analysis topics and related
information. See below, “Viewing analysis results,” “Maps,” for detailed steps.
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Loading a knowledge base—A knowledge base can be loaded at any time from the
Assessment window.

1. Choose Load knowledge base on the File menu to load a copy of an
uninstantiated knowledge base into the Assessment system and begin
a new analysis.

2. Choose the knowledge base to load from the file name list box in the Load
knowledge base dialog window.

3. Press the OK button.

By default, the file name list box displays knowledge bases contained in the \NWKB
folder under your specific EMDS-ArcView project folder (for example, \MY-EMDS\-
NWKB). If the knowledge base to be loaded is in a different folder, then use the
directory list box in the dialog window to navigate to the appropriate folder at step 2.
An actual assessment may include two or more EMDS-ArcView projects, so it may
be helpful for overall project organization to keep your team’s collection of knowl-
edge bases in the central \EMDS\NWKB folder (where NetWeaver stores them by
default), and copy them to specific project folders where they are actually used.
Aside from organization, this approach to maintaining knowledge bases has the
added benefit of maintaining readily available backups of your knowledge bases.

The Options menu on the Assessment menu bar includes startup options to auto-
matically load a specific knowledge base when the Assessment system starts.

Starting a new analysis—A new analysis can be started at any time from the As-
sessment window. Press the New button on the Assessment button bar or choose
New analysis on the File menu to reload an uninstantiated copy of the current
knowledge base into the Assessment system.

Loading an existing analysis—

1. Choose Open analysis on the File menu or press the Open button on the menu
bar to load an existing analysis (instantiated knowledge base) into the Assess-
ment system.

2. Choose the analysis to load from the file name list box in the File name dialog
window.

3. Press the OK button.

Saving the currently loaded analysis—An analysis can be saved at any time by
choosing Save analysis on the File menu or by pressing the Save button on the
Assessment button bar.
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If an analysis is already loaded in the Assessment system when you start a new
analysis or load an existing analysis, a dialog window will prompt to save the analy-
sis that is currently loaded before loading a new one. There are three options:

1. Press the Cancel button to abort the operation. The currently loaded analysis
remains in the Assessment system to continue editing.

2. Press the Save button to save the currently loaded analysis. If the analysis has
not been saved yet or if changes have been made since the last save, then a
dialog window will prompt for the analysis name. After saving the loaded analy-
sis, a file name list box is displayed to select a new analysis to load.

3. Press Don’t save. The currently loaded analysis is discarded and a File name list
box is displayed as in option 2, above, to select the name of the analysis to load.

Saving an existing analysis under a new name—At times, you may have an analy-
sis, named A, whose state you want to preserve for use in future analysis runs,
but you also want to develop a new analysis or scenario, named B, that is a further
modification of analysis A. Rather than creating a new analysis and reconstructing
the edits applied to analysis A, analysis A can be saved as analysis B or scenario B.
To rename the currently loaded analysis to a new analysis name:

1. Choose Save as on the File menu of the Assessment menu bar.

2. Enter the new name on the edit line in the File name dialog window.

3. Press the OK button.

The currently loaded analysis also can be the basis for a new scenario. Similar to
renaming an existing analysis to a new analysis name, an existing analysis also can
be saved as a scenario. To rename an existing analysis so that its state becomes
the basis for a scenario:

1. With an analysis loaded in the Assessment system, choose Save on the
Scenario submenu of the What-if menu on the Assessment menu bar.

2. Enter a new scenario name in the edit line of the Save dialog window.

3. Press the OK button to save the analysis as a scenario.

Running an analysis for the first time—Six steps are required to run an analysis in
the Assessment system for the first time:

1. Start a new analysis by pressing the New analysis button on the Assessment
button bar.

2. Select topics from the Available topics window to be included in the analysis
(see above section, “Selecting topics for analysis,” for details).
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3. Add the selected topics to the Topics for analysis window by pressing the In-
clude selected topic button in the Accessory button set.

4. Save the current state of the analysis by pressing the Save button on the As-
sessment button bar.

5. Perform the initial data requirements analysis by pressing the Data
req(uirements) button on the Assessment button bar.

6. Press the Run button on the Assessment button bar. During the initial analysis
run, the Data Engine in ArcView assembles the database for the assessment
area by querying the source databases specified in the Data Catalog and clip-
ping the data to the boundary of the assessment area.

Running subsequent analyses—After the initial analysis run has been completed as
described in the previous section, the process for subsequent runs is much more
abbreviated:

1. Set data values for data links and truth values for analysis topics as described in
the earlier sections, “Set value edit box” and “Set value dropdown list box.”

2. Press the Run button on the Assessment button bar.

Although the Save button on the Assessment button bar can be pressed before
pressing the Run button, the Assessment system automatically saves the current
state of an analysis as the first step of the run process.

Data requirements for an analysis are assessed only when the analysis is run for
the first time. An important related issue about subsequent analysis runs is that
the IN.DBF file is assembled only during the initial run of an analysis (see the pre-
vious section, “Running an analysis for the first time”). Consequently, in the current
version of EMDS, the initial analysis run freezes the state of the input data. If the
source databases for an analysis are updated after the initial analysis run, it is ne-
cessary to perform a new analysis to update the state of IN.DBF.

Viewing analysis results—

Maps—The EMDS Assessment system can display a variety of maps in ArcView
after an analysis has been run:

1. Choose Maps on the Results menu.

2. Choose the type of map to display from the cascading submenu (analysis topic
truth value, missing data indicator, or data influence rank). For an explanation of
map choices, see below.
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3. In the Map dialog window, choose a topic from the list box and press the OK
button to generate a map of the selected information in ArcView.

4. After pressing the OK button, the map can be viewed in ArcView by clicking
anywhere within the ArcView application window to raise the window to the
foreground.

Truth value maps displays the list of topics that have been included in the analysis.
Select an item from the list to display a map of truth values for the topic in ArcView
(fig. 9). A check box provides the option to create a new (additional map) or replace
the previous one (if any) in the table of contents of the Assessment view.

No data values generates a map indicating landscape features in the associated
ArcView theme for which the selected data link has no data (fig. 10). On selecting
No data values, a dialog window displays the list of data links topics associated with
topics that have been included in the analysis. A check box provides the option to
create a new (additional map) or replace the previous one (if any) in the Assess-
ment view table of contents.

Figure 9—Example of a map output, displayed in the Assessment view, from the
Assessment system displaying truth values for a topic related to salmon habitat.
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Rank values generates a map indicating influence rank by landscape feature of the
selected data link in the associated ArcView theme. A dialog window displays the
list of data link topics associated with topics that have been included in the analysis.
A check box provides the option to create a new (additional map) or replace the pre-
vious one (if any) in the Assessment view table of contents.

Graphs—

1. Choose Influence summary on the Results menu to open the influence dialog
window.

2. Choose an item from the list box and press the OK button to generate a graph of
the selected information in ArcView. For information about the types of graphs
that can be generated, see the section, “DAM results,” below.

3. After pressing the OK button, the graph can be viewed in ArcView, by clicking
anywhere within the ArcView application window to raise the window to the
foreground.

Figure 10—Map output from the Assessment system, displayed in the Assessment view,
indicating locations of features for which a particular data source is missing.
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Tables—

1. Choose Analysis tables on the Results menu.

2. This menu item cascades to two additional choices: Show and Hide.

3. Choose the Show submenu item to display all input and output tables used or
generated by NetWeaver.

4. After pressing the OK button, the set of tables can be viewed in ArcView by
clicking anywhere within the ArcView application window to raise the window to
the foreground.

While in ArcView, the tables can be closed manually, one at a time, via the control
menu on each table window. Alternatively, use Analysis Tables-Hide on the Results
menu to automatically close all NetWeaver input and output tables.

Hotlink Browser

This subsystem of the Assessment system displays the evaluated state of a
NetWeaver knowledge base in detail for a specific landscape feature that has
been selected in the Assessment view after an analysis has been run from the
Assessment system.

The Hotlink Browser window displays two child windows in its default configuration.
The upper Outline window displays an outline view of the knowledge base similar to
the display in the Available topics window of the Assessment system interface. The
logic structure of networks highlighted in the Outline window is displayed in the
lower Network window.

Opening the Hotlink Browser

In ArcView, open the Hotlink Browser to view and navigate the structure of the
evaluated knowledge base for the selected feature (fig. 11). The selected feature
is highlighted in yellow in the Assessment view in ArcView. To open the Hotlink
Browser:

1. Display a truth value map for one of the topics included in an analysis (see the
section, “Performing an analysis,” “Viewing results of an analysis,” above).

2. In the Assessment view, click on the theme in the table of contents to activate
the theme. When activated, the theme is surrounded by a raised box in the table
of contents.

3. On the ArcView tool bar, click on the hotlink tool to select it.

4. With the hotlink tool active, click on one of the landscape features displayed in
the theme to open the Hotlink Browser.
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Hotlink Browser Outline Window

The knowledge base outline is displayed in the upper Outline window of the Hotlink
Browser window (fig. 11). By default, the Outline window is displayed when the
Hotlink Browser is opened. To hide the Outline window and expand the Network
window to the full display area of the Hotlink Browser, press the Nets button at the
bottom of the application window. To restore the Outline window, press the All
button.

Truth value bars are displayed to the left of the knowledge base outline. The outline
begins with the highest level knowledge base groups or networks that were selected
for inclusion in an analysis. The outline displays only truth values for networks.

Use the up and down arrow keys to scroll through the outline or use the mouse.
Networks highlighted in the Outline window are displayed in the lower Network
window of the Hotlink Browser window.

The right arrow key expands the knowledge base outline under the highlighted
group or network. The left arrow key collapses the knowledge base outline under
the highlighted group or network.

Figure 11—The Hotlink Browser displays the evaluated state of a knowledge base
for landscape features selected from a truth value map output to the Assessment
view by the Assessment system.
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Hotlink Browser Network Window

The Network window of the Hotlink Browser displays the network structure of the
network currently selected in the Outline window (fig. 11). By default, the Network
window is displayed when the Hotlink Browser is opened. To hide the Network win-
dow and expand the Outline window to the full display area of the Hotlink Browser,
press the Outline button at the bottom of the application window. To restore the
Network window, press the All button.

As in the NetWeaver knowledge base development environment, truth value states
of evaluated networks and data links are displayed with color coding in the Network
window, with brighter greens indicating increasingly positive truth values and
brighter reds indicating increasingly negative truth values. Actual truth values or
data values for network objects displayed in the Network window are displayed in
the status bar at the bottom of the Hotlink Browser application window.

Hotlink Browser Buttons

The Hotlink Browser buttons provide control over the appearance of the Hotlink
Browser window and allow selection of new features to display within the Hotlink
Browser window (fig. 11).

Expand  expands and collapses the knowledge base outline for the group or net-
work currently highlighted in the outline. This function is duplicated by the left and
right arrow keys.

Nets  hides the Outline window and expands Network window to the full area of the
Hotlink Browser window. The Nets button is replaced by the All button.

Outline  hides the Network window and expands Outline window to the full area of
the Hotlink Browser window. The Outline button is replaced by the All button.

All  replaces the Nets button or the Outline button when either of these buttons is
pressed. Press the All button to return display of the Hotlink Browser window to its
default state in which both the Network window and the Outline window are
displayed.

Lists  toggles on and off the display of two additional list boxes.

Features  displays a dialog window with which to choose a new feature from the
Assessment view to be displayed in the Hotlink Browser window. The evaluated
state of the new feature is displayed in the Hotlink Browser window and the newly
selected feature is now highlighted in yellow in the Assessment view in ArcView.

Help  displays the cue card for the Hotlink Browser window.

Exit  closes the Hotlink Browser window.
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The Menu bar in the Hotlink Browser window duplicates all functions of the Hotlink
Browser buttons. The View menu also has a Network scale menu item that controls
sizing of the display within the Network window.

Data Acquisition Manager

Information about the influence of missing data can be as important to an assess-
ment as information that can be derived from the data that you do  have. There are
two basic questions about missing data that determine its priority for collection:

1. Which missing data should be acquired to improve completeness of an
assessment, considering the influence of the missing information?

2. How easy is it to obtain the missing data?

The DAM is a subsystem of the EMDS Assessment system (fig. 1). When the As-
sessment system runs the NetWeaver engine on a knowledge base, the engine, in
addition to performing an analysis of ecosystem states and processes, also gen-
erates information about the influence of missing data so the NetWeaver engine
automatically answers the first question in the course of processing a knowledge
base. The DAM determines the priority of missing data by synthesizing a priority
score from each data source’s influence score and a measure of its “ease of
acquisition.”

The DAM analysis is initiated by choosing Define ease of acquisition from the
Results menu on the Assessment menu bar.

The basic steps in the DAM process are:

1. Allocate relative importance among the two decision criteria, data influence and
ease of acquisition.

2. Score each missing data type for ease to acquire missing data.

3. The DAM then computes a priority for acquisition for each data type that has
missing data.

DAM Process

The DAM uses the two criteria, data influence and ease of acquiring the missing
data, to evaluate the priority of missing information. The first window displayed by
the DAM asks for a judgment about the relative importance of data influence versus
ease of acquisition (fig. 12). By default, the two criteria are equally weighted.
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Getting started—

1. In the first DAM window, drag the button on the slide bar to allocate importance
among the two decision criteria, data influence and ease of acquisition (fig. 12).

2. Press the Apply button.

3. The next display explains the process and asks you to choose one of two meth-
ods for assigning ease of acquisition. You can either directly rank ease of acqui-
sition (which the DAM will recommend if there are less than 15 data sources
with missing data) or sort data sources into general categories ranging from very
easy to very hard. Press either the Categorize button or the Don’t categorize
button.

See the section, “Sorting data types,” or the section, “Directly ranking ease,” for
details about the next step, depending on the choice in step 3. At step 3, the Back
button also may be pressed to return to the previous DAM display if it is decided
that the allocation of the importance between the two decision criteria is not correct.

Sorting data types—When there are 15 or more data sources to be ranked for ease
of acquisition, it may be helpful to first sort the full set into general categories. If this
option has been selected, all data sources initially are assigned to the very easy
category (fig. 13).

Figure 12—First step of the DAM process is allocating relative importance among the two
criteria, data influence and ease of acquiring missing data.
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1. Select one or more data sources from the very easy category.

2. Click on one of the other headings to reassign the selected data sources to that
category. Repeat this step as many times as necessary to sort the data sources.

3. When the sorting is satisfactory, press the Apply button to move to the next dis-
play in which category scores may be fine tuned. This is the same display used
to directly rank ease of acquisition, described in the next section.

Methods for making multiple data source selections conform to Microsoft Windows
conventions: Shift-click  to select a contiguous set of topics and Ctrl-click  to select
multiple noncontiguous topics. Multiple selections can be made among two or more
category list boxes at one time.

Directly ranking ease—The window displayed for direct ranking of ease also is used
to refine scores that were first assigned by sorting data sources into general
categories, as explained in the previous section (fig. 14).

If this display is entered by having chosen direct ranking, all data types are initially
assigned a score of 1.0, meaning that ease of acquisition is extremely easy (trivial).
If this display is entered by having first performed a sort into general categories, the
midrange score of the appropriate assigned category will be assigned to each data
source initially.

Figure 13—Sorting missing data sources into categories for ease of acquisition.
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In either case, select an individual data source from the list box on the left side of
the display, and adjust its score as desired. Adjustments can be made either by
typing a value directly into the edit box on the upper right side of the list box or by
clicking on the up/down spin buttons next to the edit box.

A labeled vertical bar on the right side of the display provides a verbal interpretation
of the score assigned to the currently selected data source in the list box. The bar
dynamically adjusts as scores are modified.

After scores are assigned to each data type for ease of acquisition, press the Apply
button to complete the scoring process. The DAM then synthesizes a priority for
data acquisition as a weighted average of the influence score and the ease of ac-
quisition score by using the relative weighting set on the slide bar.

DAM Results

Once the process has been completed for setting acquisition priorities for data
sources with missing values, several graphs can be selected for display in ArcView:

1. Choose Influence Summary from the Results menu on the Assessment menu
bar.

2. Next, choose Graph from the submenu.

Figure 14—Directly ranking ease of acquisition for missing data sources or refining scores
from an initial categorization.
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3. A dialog window displays the following choices:

Priority value for data links (synthesis of ease of acquisition and data influence)

Ease of acquisition (supplied by the user in the DAM)

Influence (computed by the NetWeaver knowledge base engine)

Number of rows (records) with influence (for each data source)

Percent of rows with influence (for each data source)

Number of no data values (for each data source)

Percent of no data values (for each data source)

4. Make a selection from the list of menu items.

5. Press the OK button to display the graph in ArcView.

6. Click anywhere within the ArcView application window to raise the window to the
foreground and view the graph (fig. 15).

A data type may have missing data (number of no data values is positive) but not
have any influence on improving the completeness of the assessment. The reason
for this is that the missing data are not relevant, given the availability of other data.

Figure 15—Calculated priorities for missing data sources in an example DAM analysis.
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Scenarios

The purpose of the Scenario subsystem is to explore alternative future conditions
(“what if” scenarios) and their implications for ecosystem states and processes.
Within Scenario, you can modify the input data that is evaluated by a knowledge
base or modify the structure of the knowledge base itself, in effect posing questions
such as, What if the data looked like this? or What if this topic in the knowledge
base is ignored?

The original input database for an analysis is not modified when a scenario is
created. Instead, when a what-if analysis is conducted in the Scenario subsystem,
the analysis is performed on a copy of the original input database. The original input
database for an analysis is not assembled until the run command has been exe-
cuted for the first time in the Assessment system, so scenarios cannot be run until
an actual analysis first has been run.

Creating a New Scenario

1. Choose New on the Scenario submenu of the What-if menu on the Assessment
menu bar.

2. Enter a new scenario name on the edit line of the New scenario dialog window.

3. Press the OK button to create the new scenario.

After the OK button is pressed, Scenario creates copies of the base analysis tables,
IN0.DBF and FLAG0.DBF, for the new scenario. The input tables for the first sce-
nario created are designated IN2.DBF and FLAG2.DBF (the initial analysis tables
are designated IN1.DBF and FLAG1.DBF; see the section, “Running an analysis,”
above). Tables for subsequent scenarios are numbered sequentially thereafter.

Setting Values for Topics and Data

Global data editing and structural changes to the knowledge base—Use the Set
value edit box or the Set value dropdown list box in the Details window to set a
global value for an analysis topic or data source that applies to all database records
when a scenario is run. See descriptions of Details windows components in the sec-
tion, “Assessment interface,” “Analysis windows” for methods of applying changes
to data and knowledge bases to create a scenario. Also see the earlier section,
“Setting Values for Topics and Data,” for a discussion about documenting changes
and justifications for changes.
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Editing individual input database records—

1. Choose Edit records on the What-if menu to design an alternative scenario for
the current analysis based on changes to specific database records.

2. ArcView displays the input database table and the flag table for the currently
selected scenario.

3. Modify records in the input database for the selected scenario (for help editing
database records, see the topic “Editing records” in ArcView Help).

Saving an Existing Scenario

Scenarios are automatically saved whenever a scenario is run (see “Running a
Scenario,” below). If you exit the Assessment system and the current analysis is a
scenario, the Assessment system asks if the current scenario should be saved if
any editing has been done on the scenario since it was last saved. To save the cur-
rent state of an existing scenario at any other time, choose Save on the Scenario
submenu of the What-if menu.

Saving a Scenario Under a New Name

At times, you may have a scenario (“scenario A”) whose state you want to preserve,
but you also want to develop a new scenario (“scenario B”) that is a further modifi-
cation of the currently loaded scenario. The methods discussed above for creating
a new scenario always create a new scenario by copying the base analysis files,
IN0.DBF and FLAG0.DBF. Rather than creating a new scenario and reconstructing
the edits applied to “scenario A,” use the Save as function to rename “scenario A”
as “scenario B.”

1. With a scenario loaded in the Assessment system, choose Save as on the
Scenario submenu of the What-if menu on the Assessment menu bar.

2. Enter a new scenario name in the edit line of the Save as dialog window.

3. Press the OK button to save the scenario under the new name.

After the OK button is pressed, Scenario copies IN(X).DBF and FLAG(X).DBF for
the current scenario to IN(N+1).DBF and FLAG(N+1).DBF for the new scenario,
where N indicates the last-assigned scenario sequence number. For example, if the
input tables for “scenario A” are IN2.DBF and FLAG2.DBF, and there are no other
scenarios for the current analysis, the tables for “scenario B” will be IN3.DBF and
FLAG3.DBF.
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Deleting a Scenario

1. Choose Delete on the Scenario submenu of the What-if menu on the
Assessment menu bar.

2. Click on a scenario name in the list box of the delete dialog window to highlight
the name of the scenario to be deleted.

3. Press the OK button to delete the scenario.

Running a Scenario

To run a what-if scenario analysis after modifying the input database for the sce-
nario or the knowledge base structure, press the Run button on the Assessment
button bar. If any edits have been made to the analysis via set value operations,
the scenario is automatically saved before running the scenario.

Returning to Normal Analysis Mode

To return to the standard Assessment system mode of operation, load an existing
analysis or start a new analysis.
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EMDS is a unique synthesis of several different state-of-the-art software technolo-
gies. Each of the companies involved is an innovator in its respective field. But
this fact by itself would not have been sufficient to produce the system. The current,
evolving system is the result of a lot of hard work, expertise, imagination, coordina-
tion, and cooperation of many people and organizations. It has been an honor and
a privilege to work with such a group.

Cooperators

Cooperators who participated in systems analysis and design to support de-
velopment of EMDS version 1.0 are Michael Saunders and Michael Foster
(Pennsylvania State University, University Park, PA); Richard Olson (Agricultural
Research Service, Crop Science Research Laboratory, Mississippi State, MS);
and Donald Latham (USDA Forest Service, Intermountain Research Station,
Missoula, MT).

Contractors

The Environmental Systems Research Institute (ESRI) is the primary contractor in
charge of system implementation. The ESRI ArcView application is the primary
interface to the EMDS system. Primary roles of ESRI are overall management of
system implementation, and development of extensions to ArcView to provide proj-
ect and data management functions specific to EMDS. The senior programmer in
charge of EMDS development is Scott Murray (Environmental Systems Research
Institute, Redlands, CA).
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Knowledge Garden, Inc., is a knowledge-based systems development company. Its
primary business is development, distribution, and support for the KnowledgePro
system, but it is subcontracting to ESRI on EMDS system development. The
primary role of Knowledge Garden in system development has been to develop
runtime and development interfaces to the NetWeaver engine (licensed by
Knowledge Garden from Pennsylvania State University). John Slade is president of
Knowledge Garden and the company’s senior programmer in charge of EMDS
development (Knowledge Garden, Inc., West Palm Beach, FL).

Bruce Miller (Rules of Thumb, Inc., North East, PA), working with Michael Saunders,
was the senior programmer in charge of the original development of NetWeaver. As
an independent contractor on the EMDS project, he developed the Microsoft
Windows version of the NetWeaver engine, and worked closely with Knowledge
Garden, Inc., and ESRI on interface issues between system components.
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audiotape, etc.) should contact USDA’s TARGET Center at (202) 720-2600 (voice
and TDD).

To file a complaint of discrimination, write USDA, Director, Office of Civil Rights,
Room 326-W, Whitten Building, 14th and Independence Avenue, SW, Washington,
DC 20250-9410 or call (202) 720-5964 (voice and TDD). USDA is an equal
opportunity provider and employer.
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Reynolds, Keith M. 1999.  EMDS users guide (version 2.0): knowledge-based decision
support for ecological assessment. Gen. Tech. Rep. PNW-GTR-470. Portland, OR: U.S.
Department of Agriculture, Forest Service, Pacific Northwest Research Station. 63 p.

The Ecosystem Management Decision Support (EMDS) system integrates the logical
formalism of knowledge-based reasoning into a GIS environment to provide decision sup-
port for ecological landscape assessment and evaluation. The system facilitates evaluation
of complex, abstract topics such as forest type suitability that depend on numerous, diverse
subordinate conditions because EMDS is fundamentally logic based. The object-based
architecture of EMDS knowledge bases allows incremental, evolutionary development of
complex knowledge representations.
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